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Le Full Circle est un magazine gratuit,
libre et indépendant, consacré à toutes
les versions d'Ubuntu, qui fait partie
des systèmes d'exploitation Linux. Chaque
mois, nous publions des tutoriels, que
nous espérons utiles, et des articles pro-
posés par des lecteurs. Le Podcast, un
complément du Full Circle, parle du
magazine même, mais aussi de tout ce
qui peut vous intéresser dans ce domaine.

Clause de non-responsabilité :

Cette édition spéciale vous est
fournie sans aucune garantie ; les
auteurs et le magazine Full Circle
déclinent toute responsabilité pour
des pertes ou dommages éventuels
si des lecteurs choisissent d'en appli-
quer le contenu à leurs ordinateur et
matériel ou à ceux des autres.

LA SÉRIE DES ARTICLES SUR LIBREOFFICE CONTINUE…

Dans ce numéro spécial, le volume quatre, nous continuons la compi-
lation des tutoriels LibreOffice écrits par Elmer Perry.

Vous trouverez ici une simple ré-édition des parties 27 à 36 de la série
«  LibreOffice », parues initialement dans les numéros 74 à 83 du FCM,
couvrant Dessin, Modèles, Présentation et beaucoup d'autres fonc-
tionnalités évoluées le long du chemin.

Veuillez garder à l'esprit la date de publication originale ; les versions
actuelles du matériel et des logiciels peuvent être différentes de celles
illustrées. I l convient donc de vérifier la version de votre matériel et de
vos logiciels avant d'essayer d'émuler les tutoriels dans ces numéros
spéciaux. I l se peut que les logiciels que vous avez installés soient plus
récents ou qu'il y ait des versions plus récentes disponibles dans les
dépôts de votre distribution.

Amusez-vous !

Nos coordonnées

Site Web :
http://www.fullcirclemagazine.org/

Forums :
http://ubuntuforums.org/
forumdisplay.php?f=270

IRC : #fullcirclemagazine sur
chat.freenode.net

Équipe Full Circle

Rédacteur en chef : Ronnie Tucker
(aka: RonnieTucker)
ronnie@fullcirclemagazine.org
Webmaster : Rob Kerfia
(aka: admin / linuxgeekery)
admin@fullcirclemagazine.org

Tous nos remerciements à Cano-
nical et aux nombreuses équipes de
traduction à travers le monde.

http://creativecommons.org/licenses/by-sa/3.0/
http://www.fullcirclemagazine.org/
http://ubuntuforums.org/forumdisplay.php?f=270
mailto:ronnie@fullcirclemagazine.org
mailto:admin@fullcirclemagazine.org
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L e module Draw de LibreOffice est
une application de dessin vectoriel

incluse dans la suite LibreOffice. Draw
permet de créer des graphiques que
vous pouvez utiliser dans vos docu-
ments. Bien qu'il existe des programmes
de graphiques vectoriels plus avancés
– tel qu'Inkscape – Draw vous fournit
plus d'outils que la plupart des logi-
ciels de dessin inclus dans d'autres suites
bureautiques.

Les graphiques vectoriels créent
des images en définissant des formes
géométriques telles que des cercles,
des rectangles et des polygones,
plutôt que par des points/pixels sur
l'écran. Pour cette raison, les
graphiques vectoriels changent de
taille sans distorsion.

Comme c'est le cas pour les autres
modules de LibreOffice, Draw s'intègre
bien avec les autres, ce qui en fait un
outil de choix lors de la création
graphique de vos documents.

LA MISE EN PAGES PAR DÉFAUT

La mise en pages par défaut de
Draw est plutôt basique. Vous aurez
probablement envie de la modifier
pour y inclure les barres d'outils que

vous utiliserez le plus souvent. La mise
en page comprend les éléments de
base dont vous avez besoin pour créer
une image graphique. Le centre de
l'écran est la zone où vous allez créer
votre graphique. À gauche, vous avez
le volet « Pages », montrant les dif-
férentes pages du graphique. Les gra-
phiques multi-pages sont utilisés prin-
cipalement pour les présentations et
je les traiterai à un moment ultérieur.

Par défaut, vous avez trois barres
d'outils. La barre d'outils standard est
la barre d'outils supérieure. Il s'agit de
celle que vous voyez dans la plupart
des modules de LibreOffice. Elle pro-
pose les fonctions pour créer un nou-

veau graphique, ouvrir, enregistrer, co-
pier, couper, coller, et d'autres fonc-
tions qui se rapportent à la plupart
des modules. La barre d'outils de ligne
et de remplissage se trouve en des-
sous. Celle-là contrôle l'apparence des
lignes et du remplissage d'un objet.
Au bas de la fenêtre se trouve la barre
d'outils de dessin. À partir de cette
barre d'outils, vous pouvez créer la plu-
part des objets pour votre graphique.
Vous pouvez déplacer les barres d'ou-
tils en saisissant la poignée au début
de la barre d'outils et en la faisant
glisser à l'endroit où vous le souhaitez.

La barre d'état au bas de la fe-
nêtre vous donne beaucoup d'infor-

mations utiles sur l'objet que vous
modifiez. Le type de l'objet, ses di-
mensions, son angle et d'autres infor-
mations utiles apparaîtront ici. Je me
référerai souvent à la barre d'état pen-
dant ces tutoriels sur Draw.

Au sommet et le long du bord
gauche se situent les règles. Les règles
vous indiquent votre emplacement dans
l'image. Si vous souhaitez modifier
l'unité de mesure de ces règles, vous
pouvez faire un clic droit sur la règle
et sélectionner une unité de mesure

différente. Lorsque vous avez sélec-
tionné un objet, la règle affiche des
lignes doubles pour indiquer la position
de l'objet sur le dessin.

TTUUTTOORRIIEELL
Écrit par Elmer Perry LLiibbrreeOOffffiiccee PP.. 2277 :: IInnttrroodduuccttiioonn àà DDrraaww

http://wiki.documentfoundation.org/images/d/dd/BasicGuide_OOo3.2.0.odt
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LA BARRE DE COULEURS

La barre de couleurs affiche la pa-
lette de couleurs actuelle sous la
zone de dessin. Vous pouvez l'utiliser
pour sélectionner les couleurs pour
vos objets plutôt que d'avoir à utiliser
la liste déroulante de la barre d'outils
ligne et remplissage. La première case
– la case blanche avec un X – est la
sélection sans couleur (ou invisible).
Pour afficher la barre de couleurs, cli-
quez sur Affichage > Barre d'outils >
Barre de couleurs. Pour utiliser la barre
de couleurs, faites un clic gauche sur
la couleur que vous voulez pour la
couleur de remplissage de l'objet, et
faites un clic droit pour sélectionner
la couleur de la ligne.

LES BARRES D'OUTILS
EXTENSIBLES

La plupart des icônes des barres
d'outils ont un triangle ou une flèche
vers la droite. Cela indique que l'élé-
ment est extensible. Cliquer sur la
flèche vous donne plus de choix. Vous
pouvez détacher ces éléments de la
barre d'outils, pour créer une barre
d'outils flottante. Lorsque vous déve-
loppez l'élément, vous voyez une barre
d'appui en bas. Cliquez et faites glis-
ser la barre d'appui pour créer une
barre d'outils flottante avec ces élé-
ments. Cette fonction est utile lors-
que vous avez besoin d'utiliser les
éléments à plusieurs reprises, et est
plus rapide que d'avoir à développer les
éléments à chaque fois. Lorsque vous
avez terminé, il suffit de fermer la barre
d'outils flottante en cliquant sur le

bouton Fermer dans la barre de titre.

GRILLE, LIGNES D'ACCROCHAGE
ET POINTS DE CAPTURE

Lors de la création d'une image, je
trouve qu'il est utile d'avoir des guides
pour travailler. La grille, les lignes d'ali-
gnement et les points d'accrochage
sont utiles pour de tels guides. Vous
pouvez configurer le programme pour
vous aligner sur ces guides, qui vous
aident à placer précisément vos objets
dans le dessin.

Pour configurer la grille, allez dans
Outils > Options > LibreOffice Draw >
Grille. Si vous voulez que les objets
s'alignent sur la grille par défaut, cochez
la case Capturer à la grille sous le titre

de la zone Grille. Vous avez également
la possibilité de rendre la grille visible
par défaut. La zone Résolution définit
les paramètres verticaux et horizontaux
de la grille. La zone Finesse définit le
nombre de marqueurs entre les points
de grille horizontale et verticale. Plus
la finesse est importante et plus les
changements sont précis lorsque la
capture à la grille est activée. Mais,

TUTORIEL - LIBREOFFICE P. 27
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comme pour la plupart des choses, un
juste milieu est généralement meilleur.
Vous pouvez configurer certaines op-
tions d'accrochage par défaut dans la
zone Capturer, mais je recommande
de laisser tout désactivé par défaut et
d'utiliser la barre d'options lorsque vous
avez besoin de les activer. Utilisez la
plage de capture pour contrôler la dis-
tance en pixels nécessaire avant que
votre objet ne soit positionné sur ce
point.

Contrairement à la grille, les points
d'accrochage et les lignes de capture
sont insérés lorsque vous avez besoin
d'un emplacement plus exact. Les lignes
d'alignement sont parfaites pour ali-
gner les objets verticalement ou hori-
zontalement. Pour créer une ligne ou
un point de capture, Insertion> Insé-
rer un point/une ligne de capture…
La position X contrôle la distance à
partir de la gauche de l'image. La posi-
tion Y contrôle la distance à partir du
haut. Le type détermine si vous insérez
un point de capture, une ligne de cap-
ture verticale, ou une ligne de capture
horizontale. Vous pouvez également

créer des lignes de capture en faisant
un glisser/déposer à partir des règles
horizontale ou verticale. Pour supprimer
une ligne de capture, cliquez dessus
et faites glisser de nouveau à la règle.
Pour supprimer un point de capture,
faites-y un clic droit et sélectionnez
Supprimer le point de capture.

LA BARRE D'OUTILSOPTIONS

La barre d'outils Options contient
toutes les options de capture. Si elle
n'est pas affichée, sélectionnez Affi-
chage > Barres d'outils > Options. Sur
la barre d'outils, vous pouvez basculer
entre l'affichage de vos guides ou pas,
et activer et désactiver les options
d'accrochage. Vous pouvez ancrer cette
barre d'outils en bas ou sur le côté de
la fenêtre étant donné que vous allez
l'utiliser souvent pour basculer entre
ces options.

Il reste un guide sur la barre d'ou-
tils dont nous n'avons pas encore
parlé. Ce sont les lignes d'aide lors du
déplacement. Lorsque vous sélection-
nez ces lignes d'aide lors du dépla-

cement sur la barre d'Options, puis,
lorsque vous déplacez un objet, des
pointillés s'affichent depuis les coins
de votre objet jusqu'aux règles. Ce
jeu de lignes est juste un outil de plus
pour vous aider à placer vos objets
avec précision.

CONCLUSION

LibreOffice Draw est l'application
graphique de la suite LibreOffice. Draw
sauvegarde vos graphiques dans un
format graphique vectoriel pour les uti-
liser dans vos documents créés avec
d'autres applications de la suite. Draw
vous fournit les outils permettant de
combiner des textes et des objets géo-
métriques pour créer vos graphiques.
Des guides, et la possibilité d'un aligne-
ment sur ces guides, vous aident à
placer vos objets avec précision.

Dans le prochain article LibreOf-
fice, nous nous pencherons sur la
création d'objets de base dans Draw.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
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Le Podcast Ubuntu couvre toutes les
dernières nouvelles et les problèmes
auxquels sont confrontés les utilisa-
teurs de Linux Ubuntu et les fans
du logiciel libre en général. La séance
s'adresse aussi bien au nouvel utili-
sateur qu'au plus ancien codeur. Nos
discussions portent sur le développe-
ment d'Ubuntu, mais ne sont pas trop
techniques. Nous avons la chance
d'avoir quelques supers invités, qui
viennent nous parler directement des
derniers développements passion-
nants sur lesquels ils travaillent, de
telle façon que nous pouvons tous
comprendre ! Nous parlons aussi de
la communauté Ubuntu et de son
actualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est cou-
vert par le Code de Conduite Ubuntu
et est donc adapté à tous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise)
et est disponible au téléchargement
le jour suivant.

podcast.ubuntu-uk.org

http://podcast.ubuntu-uk.org/
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TTUUTTOORRIIEELL
Écrit par Elmer Perry LLiibbrreeOOffffiiccee PP.. 2288 :: OObbjjeettss bbaassiiqquueess ddaannss DDrraaww

L orsque j'étais enfant, j'aimais jouer
avec des blocs de construction. Je

n'ai pas eu des blocs finement finis et
polis comme vous pouvez acheter pour
les enfants actuellement. Au lieu de cela,
j'ai eu des restes de morceaux de bois
de la menuiserie de mon père. Je me suis
retrouvé avec une collection de diffé-
rentes formes et tailles géométriques.
Ces blocs sont devenus des forts pour
mes soldats de plomb, des routes pour
mes voitures et même un paysage urbain
avec l'aéroport. La seule limite était mon
imagination.

Alors que mes compétences artis-
tiques n'ont jamais progressé bien au-
delà de mes cours d'arts visuels en 3e,
associer des choses me plaît toujours
et j'ai toujours apprécié la géométrie.
Mes blocs m'ont appris que la plupart
des choses peuvent se décomposer en
des formes géométriques de base com-
me des cercles, des rectangles et d'au-
tres formes géométriques 2D. Avec ces
objets, vous pouvez, même si ce n'est
que rudimentaire, tout créer. Au cœur
de LibreOffice Draw se trouvent ces
formes géométriques de base. Elles
vous permettent de dessiner n'importe
quoi et la seule limite est votre imagi-
nation. Vous trouverez tous les objets
de base sur la barre d'outils Dessin.
Commençant par le plus fondamental

de tous les éléments de dessin, la ligne,
nous allons regarder la façon d'utiliser
les objets de base disponibles dans
LibreOffice Draw.

LIGNES ET FLÈCHES
La ligne est le deuxième outil de la

barre d'outils Dessin par défaut, le
premier étant l'outil de sélection. Pour
dessiner une ligne, cliquez dans la zone
de dessin à l'endroit où vous voulez
commencer votre ligne et faites glisser
jusqu'à son extrémité. Si vous regardez
la barre d'état pendant que vous des-
sinez votre ligne, vous remarquerez
qu'il vous en indique la taille et l'angle.
Pour limiter l'angle de votre ligne à des
incréments de 45 degrés (0, 45, 90, 1 35,
1 80, -1 35, -90, -45), maintenez la touche
Maj enfoncée tout en dessinant votre
ligne.

Parfois, vous voudrez dessiner votre
ligne à partir d'un point central plutôt
que d'un point final. Maintenez enfon-
cée la touche Alt tout en dessinant
votre ligne, et celle-ci va croître à partir
de ce point central. Vous pouvez main-
tenir la touche Alt et Maj ensemble
pour tracer une ligne du point central
et limiter l'angle par incréments de 45
degrés.

Il y a aussi une barre d'outils éten-
due pour les lignes sur la barre d'outils
Dessin. Elle vous permet de dessiner
des lignes avec des points de départ
et/ou d'arrivée de formes différentes
dont des flèches. Il y a aussi une ligne
de cote pour visualiser des dimensions.
Vous pouvez utiliser les mêmes mé-
thodes pour tracer une ligne avec des
flèches que vous utilisez pour dessiner
une ligne ordinaire.

Utilisez la barre d'outils de Ligne et
remplissage pour modifier le style de
ligne et son épaisseur, et pour la colo-
rier. Assurez-vous que votre ligne est
sélectionnée lorsque vous effectuez ces
changements. Vous pouvez également
sélectionner différents styles de flèches
pour votre ligne à l'aide de la barre
d'outils Ligne et remplissage.

RECTANGLES ET CARRÉS
Si vous voulez, vous pouvez utiliser

des lignes de capture et la touche Maj
pour dessiner quatre lignes afin de créer
un rectangle ou un carré, mais Draw
vous fournit un moyen plus facile de les
créer. Le rectangle est le quatrième outil
sur la barre d'outils Dessin par défaut.
Avec lui, vous pouvez créer des rec-
tangles et des carrés.

Pour dessiner un rectangle, sélec-
tionnez l'outil Rectangle de la barre
d'outils. Cliquez sur l'endroit où vous
voulez placer le premier sommet et
faites glisser à l'emplacement du som-
met opposé. Vous faites un carré en
maintenant la touche Maj enfoncée tout
en faisant glisser. La touche Maj ga-
rantit que la largeur et la hauteur sont
toujours les mêmes.



spécial libreoffice volume quatre 7

TUTORIEL - LIBREOFFICE P. 28
Tout comme pour une ligne, vous

aurez parfois besoin de créer un rectangle
ou un carré à partir de son centre plu-
tôt que d'un des sommets. Encore une
fois, la touche Alt permet au rectangle
de se développer depuis le centre.
Utilisez la combinaison Maj + Alt pour
dessiner un carré à partir de son centre.

Les rectangles et carrés par défaut
sont dessinés avec les couleurs de ligne
et de remplissage sélectionnées. Vous
pouvez les modifier à l'aide de la barre
d'outils Ligne et remplissage. Vous pou-
vez également utiliser la barre de cou-
leurs. Faites un clic droit pour la couleur
de la ligne et un clic gauche pour la
couleur de remplissage. Vous pouvez
également contrôler l'épaisseur et le
style de la bordure à l'aide de la barre
d'outils Ligne et remplissage.

ELLIPSES ET CERCLES
L'outil Ellipse est le cinquième outil

sur la barre d'outils de dessin par défaut.
Les ellipses sont dessinées à peu près
de la même manière que les rectangles
et les carrés. Fondamentalement, vous
dessinez un rectangle qui contiendra
votre ellipse ou votre cercle. Tout com-
me avec le carré, enfoncer la touche
Maj vous permet de dessiner un cercle.
La touche Alt est utilisée pour dessiner
votre ellipse depuis le centre, la combi-
naison Maj + Alt vous permet de dessi-
ner un cercle depuis le centre.

Comme c'est le cas pour le rec-
tangle et le carré, les ellipses et les
cercles sont dessinés avec les couleurs
de ligne et de remplissage sélection-
nées. Vous pouvez les changer à l'aide
de la barre d'outils Ligne et remplis-
sage ou la barre de couleurs. La barre
d'outils Ligne et remplissage vous per-
met également de changer le style de
la bordure et son épaisseur.

FORMES ET SYMBOLES DE
BARRES D'OUTILS ÉTENDUS

Outre la barre d'outils étendue des
lignes, vous avez plusieurs autres barres
d'outils étendues à votre disposition, y
compris les formes de base (objets géo-
métriques 2D), des symboles (émoti-
cône, la lune, un cœur, etc), des flèches,
des symboles d'organigramme, des lé-
gendes et des étoiles. Ces barres d'ou-
tils étendues vous donnent un ensemble
plus large d'objets avec lesquels cons-
truire votre graphique.

Ils sont dessinés à peu près de la
même manière que les rectangles, les

carrés, les ellipses et les cercles. Vous
dessinez un rectangle contenant l'objet.
Les touches Maj et Alt fonctionnent
également sur la plupart des objets de
la même manière que pour les rec-
tangles. Vous pouvez utiliser la barre
d'outils Ligne et remplissage pour modi-
fier l'épaisseur du trait, le style de ligne,
la couleur de la ligne et la couleur de
remplissage de l'objet.

EXEMPLE DE DESSIN :
UNE FUSÉE SIMPLE

Comme je l'ai dit au début, je ne suis
pas vraiment un artiste, mais je sais
associer les formes pour créer un objet ;
nous allons donc créer une image de
fusée très simple, étape par étape. En
cours de route, je vais vous présenter
quelques nouveaux outils et concepts
pour travailler avec des formes de base.

Tout d'abord, nous allons mettre en
place une grille pour notre dessin,

Outils > Options > LibreOffice Draw >
Grille. Réglez la résolution verticale et
horizontale à 1 centimètre et les deux
subdivisions à 1 0. Cela créera un beau
quadrillage sur notre surface de dessin.
Cochez Capturer à la grille. Cela nous
aidera pour ajuster nos objets à la bonne
taille.

Commençons avec le nez. Sélection-
nez le triangle isocèle dans la barre
d'outils des formes étendues [Ndt :
neuvième bouton, celui en forme de
losange]. Dessinez, en haut de l'image,
le triangle en lui donnant une base de 2
cases de la grille et une hauteur de 2
cases également. Attribuez la couleur
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Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
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noire à la ligne et définissez la couleur
de remplissage à gris 30 %. Pour le
corps de la fusée, utilisez un rectangle,
2 cases de la grille en largeur et 6 cases
de la grille en hauteur, couleur de ligne
noire, couleur de remplissage gris 30 %.

Ajoutons quelques ailettes de
stabilisation à notre fusée. Choisissez le
triangle rectangle dans les Formes de
base étendues de la barre d'outils. Des-
sinez le triangle rectangle en bas à
droite du corps de la fusée, 2 cases de
hauteur et 1 case de largeur. Réglez la
couleur de la ligne à noir, la couleur de
remplissage à gris 40 %. Sélectionnez
l'ailette nouvellement créée et faites
Édition > Copier, puis Édition > Coller.
La copie se superposera sur la première
ailette. Faites glisser et déposez la copie
sur le côté gauche du corps de fusée.
Faites un clic droit sur la copie et Re-
fléter > Horizontalement. Déplacez-la
ensuite vers le bas le long du côté
gauche du corps de fusée. Avec la copie
toujours sélectionnée, appuyez à trois
reprises sur la flèche vers le bas pour la
déplacer juste en dessous du corps de
fusée. Faites de même avec l'ailette
droite.

Nous terminerons notre dessin avec
la tuyère du moteur. Créez un triangle
isocèle en bas au centre du corps de
fusée. Définissez sa taille au mieux. Le
point haut du triangle doit recouvrir la
partie inférieure du corps de la fusée.
Attribuez la couleur noire à la ligne et la

couleur gris 60 % au remplissage.
Assurez-vous que la tuyère est centrée
par rapport à la partie inférieure du
corps. Faites un clic droit sur le triangle,
puis Organiser > Envoyer à l'arrière.
Cela déplace le triangle derrière les
autres objets de sorte que nous ne
pouvons en voir que la partie infé-
rieure. Voilà ! Vous avez un dessin très
simple.

CONCLUSION
Les formes de base sont les blocs

de construction des images dans Draw.
Avec elles, vous pouvez créer un dessin
aussi simple ou aussi compliqué que
nécessaire pour vos documents. Vous
pouvez organiser les objets dans l'image
pour qu'ils se chevauchent et les re-
tourner pour changer l'orientation hori-
zontale ou verticale.

Dans le prochain tutoriel, je vous
montrerai comment créer des arcs, des
courbes et des polygones dans vos
images.

UBUNTU TACTILE SDK BETA

Aujourd'hui, nous [Canonical] annonçons le SDK Beta Ubuntu. Le
SDK fournit un ensemble d'API qui comprend la boîte à outils de

l'interface utilisateur, permettant aux développeurs de créer des
applications sensibles et interactives avec une interface portable Ubuntu
native. Qt Creator est un IDE avec une interface visuelle pour écrire,
tester et déployer des applications ; la documentation de l'API et un site
de développement plein de ressources et de tutoriels, facilitent la
production d'applications de qualité.

Avec une communauté dynamique et sans cesse croissante de
développeurs d'applications, Ubuntu et le SDK offrent le meilleur
écosystème pour permettre à vos applications de prospérer.

SOYEZ PRÊT À DÉMARRER, LE GUIDE POUR
L'INSTALLATION DU SDK

Pour commencer avec le SDK Ubuntu, y compris les instructions
pour une installation facile, des tutoriels et une documentation
détaillée de l'API, rendez-vous à developer.ubuntu.com/get-started

Pour vous aider à concevoir et à construire de belles applications, les
guides de conception d'application comprennent tout ce que vous
devez savoir sur UX et les meilleures pratiques de conception visuelle.
Vous les trouverez à design.ubuntu.com/apps

Vous pouvez garder votre téléphone de développement à jour avec
la dernière version en suivant les instructions à :
wiki.ubuntu.com/TouchInstallProcess

ANNONCE DE CANONICAL

http://developer.ubuntu.com/get-started
http://design.ubuntu.com/apps
http://wiki.ubuntu.com/TouchInstallProcess
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C omme j'ai dit la dernière fois, le
jeu de cubes que j'avais dans mon

enfance avait été fabriqué par mon
père qui travaillait le bois. Ils n'étaient
pas tous parfaitement proportionnés
dans des formes géométriques claires.
Parfois, ils étaient bizarres ou, comme
souvent avec le bois, ils étaient créés
en fendant le bois selon son fil au lieu
d'être découpés avec une scie. Cer-
tains avaient une forme courbée quand
leurs contre-parties avait été utilisées
pour faire une chaise ou une armoire.
Je n'ai pas mis ces formes irrégulières
au rebut, car elles me plaisaient beau-
coup. Tout dans notre monde réel
n'est pas créé à partir de lignes droites,
d'ellipses et des cercles.

Dans cette perspective, nous conti-
nuerons notre examen de LibreOffice
Draw et apprendrons à créer des poly-
gones, des arcs et des courbes. Un
polygone est un objet plan avec au
moins trois lignes droites et trois
angles. En termes géométriques, les
carrés, les rectangles et les triangles
sont tous des types de polygones.
Pour ce qui nous concerne, nous par-
lerons de polygones avec plus de
quatre côtés. Un arc, dans Draw, est
une partie d'un cercle ou d'un ovale.

Vous pouvez les faire pleins ou vides.
Une courbe est une ligne recourbée.
Nous verrons deux méthodes pour
créer des courbes, l'outil courbe lui-
même et la méthode Bezier.

DESSINER DES POLYGONES
Comme indiqué déjà, un polygone

est un objet avec de multiples côtés.
Dans Draw, il y a quatre outils pour les
polygones. Deux sont fermés et rem-
plis et deux sont ouverts et vides. Les
outils polygones vides sont utiles pour
la création d'une série de lignes. Pour
les deux types, vous avez une version
à main levée et une version restreinte
aux angles qui sont des multiples de
45 degrés. Pour créer un polygone,

choisissez l'un des outils polygone dans
la barre d'outils étendus de lignes.
Cliquez et glissez pour créer le point
de départ de la première ligne. Quand
vous lâchez le bouton de la souris, le

point final de la première ligne est
créé. Mettez la souris à l'emplace-
ment où vous voulez le point final de
la ligne suivante et cliquez. Continuez
jusqu'à ce que toutes les lignes de
votre polygone soient créées. Double-
cliquez sur le dernier point pour
terminer le polygone. Si vous utilisez
l'un des outils de polygone rempli, le
point final de la dernière ligne se
connectera automatiquement au point
de départ de la première ligne et fer-
mera le polygone.

Si vous vous servez d'un des outils
de polygone rempli, Draw remplit le
polygone avec la couleur de remplis-

sage actuelle et règle la couleur des
lignes à la couleur de ligne actuelle-
ment sélectionnée. Vous pouvez les
changer avec la barre d'outils Ligne et
remplissage ou la barre des couleurs.

AJOUTER LA BARRE D'OUTILS
DES CERCLES ET DES OVALES

Pour un accès rapide aux outils
arcs et segments, il faut ajouter la
barre d'outils Cercles et ovales à la
barre d'outils Dessin. Faites un clic-
droit sur la barre d'outils Dessin et
choisissez Personnaliser la barre d'ou-
tils… Cela ouvrira le dialogue Person-
naliser. Cliquez sur le bouton Ajouter.
Dans la liste Catégorie, sélectionnez
Dessin. Dans la liste Commandes, trou-
vez les outils Ellipse – il y en a deux.
Vous voulez celui avec la description
«  En personnalisant la barre d'out ils,
vous pouvez ajouter une icône Ellipse
qui ouvre la barre d'outils Cercles et
ovales». Cliquez sur le bouton Ajouter.
Cliquez sur Fermer pour fermer le dia-
logue de sélection.

Vous pouvez bouger la nouvelle
icône là où vous la voulez sur la barre
d'outils avec les flèches haut et bas.
J'ai placé la mienne au-dessous de
l'outil Ellipse. En fait, nous n'avons
plus besoin de l'outil Ellipse, car c'est
inclus dans la barre d'outils Cercles et
ovales. Décochez l'outil Ellipse. Cliquez
sur le bouton OK et vous devez main-
tenant voir la barre d'outils sur votre
barre d'outils Dessin.



spécial libreoffice volume quatre 1 0

TUTORIEL - LIBREOFFICE P. 29

DESSINER DES ARCS OU DES

SEGMENTS

Pour dessiner un
arc ou un segment,
choisissez l'un des
outils de la barre
d'outils des Cercles
et ovales que vous

venez d'ajouter. Cliquez et faites glis-
ser pour créer un cercle ou un ovale
fermé. Relâchez le bouton de la souris.
Cliquez dans le cercle ou l'ovale à
l'endroit où vous voulez que l'arc ou
le segment commence. Bougez la sou-
ris autour du cercle ou de l'ovale pour

créer l'arc ou le segment. Cliquez une
deuxième fois pour créer le point fi-
nal pour l'arc ou le segment. La barre
d'état affichera l'angle à partir du
centre des points, pendant que vous
bougez autour du cercle ou de l'ovale.
Cela peut vous aider à créer des arcs
et segments précis et justes.

DESSINER DES COURBES

Une courbe est une ligne courbée
et non pas un segment d'un cercle ou
d'un ovale. Pour dessiner une courbe,
sélectionnez l'outil courbe dans la
barre d'outil ligne. Cliquez sur le point
de départ et déplacez votre souris
pour dessiner une ligne. Relâchez le
bouton au point le plus haut de votre
courbe. Bougez la souris pour faire
courber la ligne jusqu'au point où vous
voulez que la courbe se termine. Dou-
ble-cliquez pour compléter la courbe.

LES COURBES DE BEZIER
Une courbe de Bezier est une

courbe graduelle avec un point de dé-

part, un point final et deux points de
contrôle. Les mathématiques derrière
la courbe de Bézier dépassent la por-
tée de cet article, mais vous n'avez
pas besoin de les comprendre pour
en dessiner une. Pour dessiner une
courbe de Bézier, sélectionnez l'outil
courbe dans la barre d'outils des
lignes. Cliquez sur le point de départ,
glissez jusqu'au point final et double-
cliquez. Cliquez sur l'outil Points sur la
barre d'outils Dessin (F8 sur le clavier)
et la barre d'outils Éditer les points
s'affichera. Sélectionnez soit le point
de départ, soit le point final (le point
de départ est le plus grand carré).
Sélectionnez l'outil Jonction lisse ou
Jonction symétrique dans la barre
d'outils Éditer les points. Une ligne en
pointillés et un cercle apparaîtront,
indiquant le point de contrôle pour ce
point-là. Bougez le point de contrôle
afin de créer la courbe pour ce point-
là. Répétez pour l'autre point.

CONCLUSION
Puisque tout n'est pas créé à

partir de lignes droites, d'ellipses et
de cercles, les créateurs de Draw nous

proposent plus d'outils pour créer des
objets. Un polygone peut créer un
objet ayant plus de quatre côtés. Arcs
et segments nous donnent des par-
ties et des segments d'un cercle ou
une ellipse. Courbes nous donne la
capacité de courber une ligne pour
créer des formes différentes. Avec
ces outils supplémentaires, Draw vous
permet de créer des images plus
complexes pour vos documents.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
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Lorsque vous travaillez avec des blocs
de bois, vous devez parfois modifier

la forme d'un bloc, le personnalisant
pour un usage spécifique. Vous pouvez
utiliser un rabot ou du papier de verre
pour faire un côté incliné ou un bord
arrondi. Vous pouvez utiliser une scie
pour virer un coin. Tout cela pour créer
un bloc spécial personnalisé différent
des autres blocs que vous avez.

Parfois, nous devons faire la même
chose avec nos blocs numériques. Les
outils d'édition intégrés à LibreOffice
Draw deviennent les rabot, papier de
verre et scie numériques. En fait, vous
pouvez faire des trucs que je n'ai jamais
rêvé de faire à mes blocs lorsque j'étais
enfant.

LAFENÊTRE DE DIALOGUELIGNE
(LINE)

La fenêtre de dialogue Ligne vous
permet de modifier l'apparence des
lignes de votre objet. Pour accéder à la
fenêtre de dialogue Ligne, faites un clic
droit sur votre objet, puis sélectionnez
Ligne. De là, vous pouvez modifier le
style de la ligne (continue, en pointillé,
tiret-point, etc.), la couleur, la largeur et
la transparence. Vous pouvez également
ajouter des styles de flèches pour le

début et la fin de votre ligne. N'oubliez
pas que, pour les objets fermés (trian-
gles, carrés, cercles, etc.), les flèches ne
sont pas dessinées sur les lignes. En
dessous des styles de flèches, vous pou-
vez en ajuster la largeur. « Centre »
(Center) place le centre de la pointe de
flèche sur le point final de la ligne
sélectionnée. « Synchroniser les extré-
mités » (Synchronize ends) change auto-
matiquement les deux pointes de flè-
ches lorsque vous modifiez le style, la
largeur ou le centre d'une des extré-
mités. « Style d'angle » (Corner style)
contrôle la façon dont l'angle de votre
objet est dessiné. « Style de fin » (Cap
style) contrôle à quoi ressembleront les

points de terminaison des lignes sans
flèches.

Si vous travaillez avec un objet ouvert,
il y a un onglet « Ombre » (Shadow).
Cela vous permet de créer une ombre
pour la ligne en définissant la position,
la distance, la couleur et la transpa-
rence de l'ombre.

Les onglets « Styles de lignes » (Line
Styles) et « Styles de flèches » (Arrow
Styles) vous permettent d'ajouter, de
modifier, de supprimer, puis d'enregistrer
différents styles de lignes et de flèches.
Vous pouvez jouer avec ceux-ci, mais
généralement vous trouverez ce dont
vous avez besoin dans les styles prédé-

finis. Si ce n'est pas le cas, n'hésitez pas
à créer les vôtres.

LAFENÊTRE DE DIALOGUE DE
REMPLISSAGE (AREA)

La fenêtre de dialogue de remplis-
sage s'applique aux objets qui sont fer-
més et s'applique à l'espace à l'intérieur
de l'objet. Vous pouvez changer la
couleur de remplissage ainsi que la
manière dont l'objet est rempli. Pour
accéder à la fenêtre de dialogue de
remplissage, cliquez droit sur l'objet et
sélectionnez Remplissage (Area).

L'onglet Remplissage contrôle ce
qui remplit l'objet. Vous pouvez choisir
la couleur, le dégradé (gradient), les
hachures (hatching), et l'image de rem-
plissage dans la liste déroulante « Rem-
plir » (Fill). Une fois que vous avez sélec-
tionné le type de remplissage, vous
pouvez sélectionner un remplissage dans



spécial libreoffice volume quatre 1 2

TUTORIEL - LIBREOFFICE P. 30
la liste. La zone d'aperçu vous montre
le résultat de vos sélections.

L'onglet « Ombre » (Shadow) vous
permet d'ajouter une ombre sous votre
objet. Cochez « Appliquer l'ombre » (Use
Shadow) pour créer une ombre. La po-
sition détermine l'emplacement de l'om-
bre et la distance détermine l'éloigne-
ment par rapport à l'objet. « Couleur »
détermine la couleur de l'ombre et
«  Transparence » définit l'opacité de
l'ombre.

Sur l'onglet Transparence, nous déter-
minons l'opacité du remplissage de
l'objet. Nous avons trois options pour la
transparence du remplissage. « Aucune
transparence » signifie que le remplissage
est complètement opaque. Avec la Trans-
parence, vous pouvez définir un pourcen-
tage pour l'ensemble de la zone. « Dé-
gradé » (Gradient) est l'option avec le
plus de paramètres et la possibilité de
créer les effets les plus intéressants.
Vous avez six choix pour les types de
dégradés : linéaire, axial, radial, ellip-
soïde, quadratique et carré. Pour tous

sauf le linéaire et l'axial, vous pouvez
contrôler le centre XY du dégradé. Le
centre XY est le point où l'objet est le
plus clair ou plus transparent. Sauf pour
le radial, vous pouvez également défi-
nir un angle pour la zone de dégradé.
Les paramètres de bordure (Border) ré-
duisent la taille de la zone transparente.
Plus le pourcentage est élevé, moins
grande est la surface transparente. Uti-
lisez les valeurs initiale et finale pour
modifier les niveaux d'opacité du début
et de la fin. Par exemple, si vous ne voulez
pas d'endroit totalement clair sur votre
objet, vous pouvez commencer avec
une valeur de 1 0 ou 1 5 %.

Les onglets de couleurs, dégradés,
hachures et bitmaps vous permettent
de créer de nouveaux styles de rem-

plissage en définissant des bitmaps, des
dégradés, des hachures et de nouvelles
couleurs.

LAFENÊTRE DE DIALOGUE
POSITION ET TAILLE (SIZE AND
POSITION)

En plus de contrôler la position et la
taille d'un objet, la boîte de dialogue
Position et taille permet aussi de con-
trôler la rotation, l'inclinaison et le rayon
d'angle d'un objet. Pour accéder à la
fenêtre de dialogue Position et taille,
faites un clic droit sur votre objet, puis
sélectionnez « Position et taille ».

L'onglet Position et taille fait ce à
quoi vous vous attendez. Vous pouvez
contrôler la position XY sur la grille de
l'objet et sa largeur et hauteur. Le point
de base pour chacune des options dé-
termine le point parmi neuf sur l'objet
à partir duquel la position ou la taille
est calculée. Il y a une case à cocher
«  Proportionnel » sous la taille pour aider
à maintenir le ratio d'aspect de l'objet
(n'importe quel changement de hauteur
créera un changement de largeur et vice
versa). Vous avez également la possi-
bilité de protéger la position ou la taille
afin d'éviter de les modifier par inadver-
tance. L'option « adapter » concerne seu-
lement les blocs de texte et vous per-
met d'adapter la largeur et/ou la hauteur
pourfaire correspondre le texte.

Avec l'onglet Rotation, vous pouvez
contrôler la rotation de l'objet. C'est
généralement beaucoup plus précis
que l'utilisation de l'outil rotation. Vous
pouvez sélectionner le point de rota-
tion au moyen des zones de saisie, ou
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en sélectionnant un point de rotation
dans la zone de Paramétrages par dé-
faut. Sélectionnez votre angle dans la
zone de saisie ou en sélectionnant un
point sur la boussole de Paramétrages
par défaut des angles.

Enfin, l'onglet « Inclinaison et rayon
d'angle » (Slant & Corner radius) vous
permet de contrôler le rayon d'angle et
l'inclinaison (pensez au texte en ita-
lique). Pensez au rayon d'angle comme
à un papier de verre pour arrondir un
angle. Plus vous frottez, plus le coin
devient rond. Plus le nombre est grand,
plus rond sera le coin. Si vous définissez
un rayon d'angle assez élevé sur un
rectangle, il deviendra un ovale. L'incli-

naison (Basculer), donnée comme un
angle, bascule l'objet vers la droite pour
un angle positif et vers la gauche pour
un angle négatif. En utilisant le rayon
d'angle et l'inclinaison, vous pouvez obte-
nir des formes intéressantes. Le rayon
d'angle est bloqué pour certains objets.

ORGANISER, ALIGNEMENT,
REFLÉTER, CONVERTIR

Parfois, il devient nécessaire d'empiler
les objets, de les aligner, de les refléter
ou juste de les convertir en quelque
chose que vous pouvez modifier d'une
manière différente. Toutes les com-
mandes suivantes se trouvent en cli-
quant droit sur l'objet. Elles sont éga-
lementdisponiblesdans lemenuModifier.

Les options d'organisation vous per-
mettent de contrôler la position dans la
pile d'objets. Lorsque vous avez plusieurs

objets qui se chevauchent, vous devrez
peut-être modifier l'ordre dans lequel
ils sont empilés. Par défaut, ils se rangent
dans l'ordre dans lequel ils sont créés,
le dernier sur le dessus. En utilisant les
options d'organisation, vous pouvez pous-
ser des objets vers l'avant ou vers
l'arrière dans la pile jusqu'à ce que vous
obteniez les résultats souhaités.

« Alignement » vous permet d'aligner
les objets entre eux ou par rapport à la
page. Si vous avez sélectionné un seul
objet, l'objet s'aligne à la page actuelle.
Si plus d'un objet est sélectionné, ils
s'aligneront les uns par rapport aux autres.
Le plus grand des objets contrôle habi-
tuellement l'emplacement final, et les
autres objets sont déplacés pour s'aligner
sur la position sélectionnée de cet
objet-là. Les options d'alignement sont
gauche, droite, centrage horizontal, cen-
trage vertical, haut et bas. Draw a une
barre d'outils d'alignement en plus du
menu contextuel et du menu Modifier.

Les options de Refléter (Flip) sont
simples. Vous pouvez refléter un objet
verticalement (de haut en bas) ou
horizontalement (de gauche à droite).

Il y a beaucoup d'options sous le
menu contextuel > Convertir, mais il y
en a une en particulier sur laquelle je
veux attirer votre attention, Convertir >
En courbe ( Convert > To Curve ). En
convertissant n'importe quel objet en
une courbe, vous pouvez modifier les

points à l'intérieur de cet objet, ce qui
vous permet de réaliser des formes
tout à fait originales. Une fois qu'un
objet est une courbe, vous pouvez
ajouter des points, supprimer des points
et utiliser les outils de translation de
point sur les points de l'objet. Trans-
formez un rectangle en une courbe,
puis commencez à ajouter, déplacer et
manipuler les points pour voir ce que
vous pouvez créer.

CONCLUSION
Les options de Draw vous permet-

tant de modifier un objet sont nom-
breuses. En utilisant les bons outils sur
un objet, vous pouvez créer presque
n'importe quelle forme imaginable (peut-
être quelques-unes que vous n'auriez
jamais imaginées). Je vous encourage à
jouer avec ces outils et voir ce que vous
pouvez faire avec. On ne sait jamais,
vous pourriez découvrir ce petit bout
d'artiste ou de créateur qui est en vous.

http://eeperry.wordpress.com
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S i vous travaillez beaucoup avec
LibreOffice, vous verrez que vous

utilisez presque toujours la même mise
en forme. Que vous l'utilisiez pour
écrire des lettres ou pour créer le
prochain best-seller, vous passez beau-
coup de temps à mettre en place les
mêmes styles maintes et maintes fois.
Les modèles sont la réponse à ce pro-
blème. Un modèle est une maquette
de document utilisée pour créer d'au-
tres documents. Toutes les applica-
tions LibreOffice peuvent utiliser des
modèles. En fait, chaque fois que vous
créez un nouveau document, Libre-
Office utilise un modèle par défaut.

Les Styles sont essentiels pour la
création de modèles. Les styles sont
une façon prédéfinie d'afficher des
informations. J'ai parlé de l'importance
de l'utilisation des styles pour la pre-
mière fois il y a longtemps, dans la
partie 3 de cette série, en vous mon-
trant comment les styles aident à créer
un aspect uniforme dans votre docu-
ment tout en vous faisant gagner du
temps. Dans l'esprit de vous faire éco-
nomiser du temps, nous pouvons ajou-
ter une utilisation de plus aux styles,
la création de modèles.

METTRE EN PLACE UN MODÈLE

D'une lettre commerciale à un ar-
ticle de recherche scientifique, tout
requiert une mise en page et un for-
mat. Disons que nous écrivons un
document qui nécessite un format de
plan numéroté avec des sous-niveaux.
Une autre exigence est que le titre et
l'auteur s'affichent en haut de chaque
page et le numéro de page en bas
avec le format « Page # de # ».

Abordons tout d'abord le style de
numérotation. Dans un nouveau docu-
ment Writer, ouvrez la fenêtre « Styles
et formatage ». Cliquez sur l'icône de
Styles de liste (la dernière sur la barre
d'outils de Styles). Choisissez « Numé-
rotation 1 ». Faites un clic droit sur
«  Numérotation 1 », puis cliquez sur
Modifier. Dans l'onglet plan, prendre
le style qui porte la mention « Numé-
rique avec tous les sous-niveaux » lors-
que vous passez la souris dessus. Cliquez
sur les boutonsAppliqueretOK.

Maintenant, occupons-nous de l'en-
tête et du pied de page. Ouvrez la
fenêtre Styles et formatage et cliquez
sur l'icône de Styles de Page (avant-
dernier de la barre d'outils de Styles).

Faites un clic droit sur le style de page
Standard, puis sélectionnez Modifier.
Dans l'onglet en-tête, cochez Activer
l'en-tête, puis allez dans l'onglet pied
de page et cochez Activer le pied de
page. Cliquez sur OK pour enregistrer
les modifications. Cliquez dans la zone
d'en-tête de la première page, puis
Insertion > Champs > Titre. Tapez une
espace et « par », puis Insertion >
Champs > Auteur. Déplacez votre souris
vers le pied de page au bas de la page.
Tapez « Page », une espace, puis Inser-

tion > Champs > Numéro de Page. Tapez
espace, « de », espace, puis Insertion >
Champs > Nombre de pages.

ENREGISTRER LE MODÈLE

Nous sommes maintenant prêts à
enregistrer notre modèle. Fichier >
Enregistrer comme modèle ouvre le
gestionnaire de modèles. Choisissez le
dossier de modèles où vous souhaitez
stocker votre modèle. Cliquez sur En-
registrer. Une boîte de dialogue vous
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invite à nommer le modèle. Entrez le
nom que vous souhaitez donner au
modèle et cliquez sur accepter. Fer-
mez le gestionnaire de modèles.

UTILISER LE MODÈLE

Nous allons maintenant utiliser le
modèle nouvellement créé. Fichier >
Nouveau > Modèles et documents.
Ouvrez le dossier où vous avez enre-
gistré votre modèle, puis double-cli-
quez dessus. Le titre est celui que vous
avez donné au modèle. Modifions-le.
Fichier > Propriétés. Sélectionnez

l'onglet Description et modifiez le
titre. Cliquez sur OK. Le titre dans
l'en-tête prendra la nouvelle valeur.

Essayons le système de numé-
rotation de plan. Ouvrez les Styles et
formatage, cliquez sur l'icône de
styles de liste et double-cliquez sur
Numérotation 1 . Ce que vous allez
entrer va prendre le style de liste que
nous avons défini pour Numérotation
1 lors de la création du modèle. Ajou-
tez du texte et n'oubliez pas d'ajouter
plusieurs niveaux pour vous assurer
que ça marche. Maintenant, vous pou-
vez enregistrer votre document comme

vous le feriez normalement. Cela ne
l'enregistre pas comme modèle, mais
comme un nouveau fichier sur votre
ordinateur.

DÉFINIR UN NOUVEAU

MODÈLE PAR DÉFAUT

Si vous avez besoin d'utiliser votre
nouveau modèle la plupart du temps,

pourquoi ne pas en faire votre modèle
par défaut ? Cela se fait facilement
dans LibreOffice. Fichier > Nouveau >
Modèles et documents. Naviguez jus-
qu'au dossier qui contient votre modèle
et sélectionnez-le. Cliquez sur le bou-
ton « Définir comme modèle par dé-
faut ». Maintenant, chaque fois que
vous démarrez un nouveau document
de ce type, LibreOffice utilisera votre
modèle plutôt que le modèle par dé-
faut fourni avec LibreOffice.

DIFFÉRENTES SOURCES POUR
LES MODÈLES

Créer vos propres modèles est
super, mais vous n'aurez pas toujours
besoin de faire tout ce travail. Le dé-
pôt officiel de modèles http://tem-
plates.libreoffice.org a des centaines
de modèles que vous pouvez essayer
et utiliser. Pour utiliser un modèle
particulier, importez-le dans le Ges-
tionnaire de modèles.

http://templates.libreoffice.org
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Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu. Son blog
est à http://eeperry.wordpress.com
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Certains modèles sont des collec-
tions. Elles ont une extension .OXT.
Pour importer ces modèles, utilisez le
gestionnaire d'extensions, Outils > Ges-
tionnaire des extensions. Cliquez sur
Ajouter et recherchez le fichier OXT
téléchargé. Sélectionnez le fichier et
cliquez sur Ouvrir. Le gestionnaire d'ex-
tensions traitera le fichier et ajoutera
la collection à votre Gestionnaire de
modèles.

CONCLUSION

Les modèles sont un moyen de
répéter la mise en forme d'un docu-
ment à un autre. La création et l'enre-
gistrement des modèles s'appuie prin-
cipalement sur l'utilisation des styles.
Même si j'ai démontré la création d'un
modèle dans Writer, vous pouvez
aussi créer des modèles dans les au-
tres modules de LibreOffice. Vous
pouvez même définir votre modèle par
défaut pour cet autre type de docu-
ment. Les modèles sont un outil de
plus pour gagner du temps au sein de
la suite LibreOffice.

ÉDITIONS SPÉCIALES PYTHON :

http://www.fullcirclemag.fr/?
download/224

http://www.fullcirclemag.fr?
download/230

http://www.fullcirclemag.fr/?
download/231

http://www.fullcirclemag.fr/?
download/370

http://www.fullcirclemag.fr/?
download/371

http://www.fullcirclemag.fr/?
download/372

http://www.fullcirclemag.fr/?
download/240

http://www.fullcirclemag.fr/?
download/268

http://www.fullcirclemag.fr/?
download/272

http://eeperry.wordpress.com
http://www.fullcirclemag.fr/?download/224
http://www.fullcirclemag.fr/?download/230
http://www.fullcirclemag.fr/?download/272
http://www.fullcirclemag.fr?download/370
http://www.fullcirclemag.fr/?download/371
http://www.fullcirclemag.fr/?download/372
http://www.fullcirclemag.fr/?download/231
http://www.fullcirclemag.fr/?download/240
http://www.fullcirclemag.fr/?download/268
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S i vous avez déjà animé une pré-
sentation, vous savez que revenir

vers l'ordinateur pour faire avancer
vos diapositives est pénible, surtout
si, comme moi, vous vous déplacez
beaucoup et faites activement parti-
ciper votre auditoire. J'ai récemment
présenté une session de formation au
travail et je n'ai cessé de vouloir une
télécommande. La Document Founda-
tion a fourni une solution avec l'ap-
plication Android, Impress Remote (té-
lécommande Impress). Impress Remote
vous permet de contrôler votre pré-
sentation Impress à partir de votre
téléphone ou tablette Android. Impress
Remote nécessite LibreOffice en ver-
sion 4.0.1 ou supérieure et un télé-
phone ou une tablette sous Android
2.3 ou supérieur. Si vous possédez un
téléphone ou une tablette récente et
que votre distribution Linux est à jour,
l'utilisation de ce programme devrait
être assez facile.

INSTALLATION

Nous aurons besoin de faire des
changements à notre configuration
LibreOffice Impress pour exécuter le
programme à distance. Commencez
par ouvrir une présentation (nouvelle

ou existante). Puis Outils > Options >
LibreOffice Impress > Général. Cochez
la case « Activer le contrôle à distance ».
Cliquez sur OK. Outils > Options >
LibreOffice > Avancé. Cochez la case
«  Activer les fonctions expérimentales ».
Cliquez sur OK. Redémarrez LibreOf-
fice et ouvrez votre présentation.

Lorsque nous installerons l'applica-
tion de télécommande, nous aurons
besoin de l'adresse IP de l'ordinateur
qui exécute LibreOffice. Dans un ter-
minal Linux, la commande suivante
devrait fonctionner pour la plupart des
utilisateurs : ifconfig eth0 Les infor-
mations dont vous avez besoin sont
sur la ligne qui commence par « inet
addr: xxx.xxx.xxx.xxx », où xxx.xxx.xxx.xxx
est l'adresse IP de votre ordinateur.
Notez cette adresse et conservez-la
pour plus tard. Vous en aurez besoin
lorsque vous configurerez l'application
de télécommande.

Maintenant, nous installons l'appli
Impress Remote. Dans la boutique
Google Play, recherchez Impress Re-
mote et installez l'application sur votre
téléphone ou votre tablette. La pre-
mière fois que vous ouvrez l'appli, vous
voyez un écran presque vide. Sélec-

tionnez « Ajoutermanuellement un ordi-
nateur en WiFi ». Entrez un nom pour
l'ordinateur et son adresse IP. Sélec-
tionnez « Ajouter ». Sélectionnez l'ordi-
nateur dans la liste et laissez-le se
connecter. De retour dans Impress, Dia-
porama > Contrôle à distance Impress
(Impress Remote). Sélectionnez votre
appareil à distance. Entrez le code qui
vous a été donné par l'application.
Cliquez sur Sélectionner. Dans l'appli
à distance, cliquez sur « Démarrer la
présentation » pour démarrer la présen-
tation.

Si votre ordinateur dispose du Blue-
tooth, vous pouvez également vous
connecter par l'appairage de votre télé-
phone avec votre ordinateur. Lorsque
vous ouvrez l'appli, il va rechercher

votre appareil via Bluetooth, et il vous
suffit de sélectionner votre appareil
dans la liste. Vous avez toujours besoin
d'activer les options de communi-
cation à distance et expérimentales
dans LibreOffice.

REMARQUE : Si vous utilisez un pare-
feu sur votre ordinateur, vous devez
ouvrir le port TCP 1 599 pour les
communications parWiFi.

UTILISER L'APPLI IMPRESS
REMOTE

L'appli est assez basique, mais il faut
se rendre compte que moins c'est com-
pliqué mieux c'est quand vous don-
nez une présentation. La barre d'outils
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dans la partie supérieure affiche l'heure
actuelle, ce qui est pratique lorsque
votre présentation doit commencer
ou se terminer à des heures définies.
À gauche de l'horloge est le
commutateur de vues et à droite de
l'heure est le menu de l'appli.

Quand vous commencez une pré-
sentation, vous obtenez la vue de
défilement des diapositives de votre
présentation. Cette vue est la plus
utile parce que, quand vous êtes en
mode de défilement, vous pouvez
également voir toutes les notes que
vous avez faites pour la diapositive.
Bien que vous puissiez utiliser votre

doigt pour naviguer dans le diapo-
rama, ce n'est pas la meilleure mé-
thode, sauf si vous avez juste besoin
d'avancer ou de reculer de plusieurs
diapositives à la fois. La meilleure
façon de – ou celle qui a été conçue
pour – naviguer dans votre présen-

tation est d'utiliser les boutons volume
haut et bas. Le bouton haut vous
avance dans la présentation et le bou-
ton bas fait revenir en arrière.

Parfois, vous avez besoin de faire
une pause et déplacer l'attention de
votre auditoire de l'écran vers autre
chose. Impress Remote vous donne la
capacité de vider l'écran. Dans le menu
de l'appli, sélectionnez « Blank Screen ».
Votre écran de présentation se vide.
Lorsque vous êtes prêt à retourner à
la présentation, cliquez simplement sur
« Retour à la diapo ». La présentation
reprendra là où vous l'avez laissée.

Vous pouvez afficher vos diaposi-
tives de deux manières différentes :
celle que nous avons déjà vue, le mode
défilement, et le mode liste. Vous
pouvez basculer entre les deux modes
en cliquant sur le bouton sélecteur de

vue. Dans le mode défilement, vous
vous déplacez rapidement jusqu'à
une diapositive en faisant glisser avec
votre doigt. Pour sélectionner une
diapositive en mode liste, il suffit de
sélectionner la diapositive. Ce n'est pra-
tique que pour les diapositives figées.
Toute diapositive ayant des animations
nécessitera l'utilisation des boutons
volume haut et bas.

Si vous cliquez sur l'horloge, vous
avez la possibilité de laisser l'heure
actuelle ou de démarrer un chrono-
mètre. Choisissez le chronomètre pour
l'utiliser. Vous obtiendrez des options
Start et Reset. Appuyez sur Start pour
lancer le chronomètre. Le chrono com-
mencera à compter et les options
changeront en Pause et Restart. Choi-
sissez Pause pour interrompre le chrono
et Restart pour recommencer à partir
de 0.00. Ceci est pratique pour chrono-
métrer une activité ou travailler sur le
débit de votre présentation.

Dans le menu de l'appli, il y a un
choix pour les Options. La première
option est d'utiliser les boutons de
volume haut et bas pour contrôler la
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présentation. Il me semble qu'il n'y ait
pas de raison valable de décocher celle-
ci, mais je pense qu'elle est là parce
que quelqu'un avait une bonne raison.
La deuxième option est d'activer une
connexion sans fil entre le téléphone
et l'ordinateur. Cela permet à l'appli
de rechercher automatiquement les
périphériques du réseau sans fil qui
ont LibreOffice Impress ouvert avec
la fonction de connexion à distance
activée. Enfin, l'option de changer d'ordi-
nateur vous permet de basculer sur
un autre ordinateur.

CONCLUSION

Quand on anime une présentation,
il est agréable de pouvoir bouger.
L'appli Android Impress Remote vous
donne cette possibilité en vous per-
mettant de contrôler votre présenta-
tion Impress à partir de votre télé-
phone ou tablette Android. L'appli est
facile à configurer via Bluetooth ou
WiFi. L'interface est dépouillée, ce qui
facilite son utilisation et son contrôle.
Comme l'appli a été développée par
les mêmes personnes qui développent
LibreOffice, la compatibilité future est
pratiquement assurée.

TUTORIEL - LIBREOFFICE P. 32

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu. Voici son
blog : http://eeperry.wordpress.com

ÉDITIONS SPÉCIALES PYTHON :

http://www.fullcirclemag.fr/?download/224 http://www.fullcirclemag.fr?download/230

http://www.fullcirclemag.fr/?download/231 http://www.fullcirclemag.fr/?download/240

http://www.fullcirclemag.fr/?download/268 http://www.fullcirclemag.fr/?download/272

http://eeperry.wordpress.com
http://www.fullcirclemag.fr/?download/224
http://www.fullcirclemag.fr?download/230
http://www.fullcirclemag.fr/?download/231
http://www.fullcirclemag.fr/?download/240
http://www.fullcirclemag.fr/?download/268
http://www.fullcirclemag.fr/?download/272
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Écrit par Elmer Perry

U tiliser HSQLDB, le système de
gestion de base de données (SGBD,

Database Management System, DMS, en
anglais) par défaut dans LibreOffice Base
est très bien pour la création de nou-
velles bases de données, mais parfois vous
avez besoin de vous connecter à une
base de données existante sur un autre
SGBD comme MySQL, dBase, JDBC, Oracle,
PostgreSQL, et d'autres. Je vous ai mon-
tré comment vous connecter à une base
de données faite à partir d'une simple
feuille de calcul dans le numéro 52. Au-
jourd'hui, je vais vous montrer comment
vous connecter à une base de données
créée avec MySQL.

MySQL est un SGBD utilisé sur de
nombreux sites Web. Wordpress et d'au-
tres systèmes de gestion de contenu
utilisent MySQL pour leurs bases de don-
nées. Il se peut que vous ayez de nom-
breuses raisons d'accéder à une base de
données créée dans MySQL. MySQL est
Open Source et vous pouvez l'installer à
partir de votre gestionnaire de logiciels.

INSTALLER MYSQL
Installer MySQL à partir de votre ges-

tionnaire de logiciel nécessite l'installa-
tion de deux paquets. Le premier paquet
est « mysql-client », le programme client
pour MySQL. Il vous permet d'interagir
avec MySQL.

Si vous installez MySQL sur votre
machine actuelle, vous devrez aussi ins-
taller le paquet serveur de MySQL : « mysql-
server ». Lorsque vous installez le paquet
serveur, il vous demande un mot de passe
« root » et demande une confirmation.
Ceci est votre mot de passe maître pour
MySQL. Notez-le quelque part. Vous en
aurez besoin plus tard. Si vous vous con-
nectez à une base de données sur un
autre ordinateur, vous n'avez pas besoin
de ce paquet.

Le dernier paquet que vous devez ins-
taller est « libreoffice-mysql-connector ».
Ce paquet va vous permettre de vous
connecter à MySQL sans utiliser de
surcouche ODBC ou JDBC.

CRÉER UNE BASE DE
DONNÉES MYSQL DE TEST

Si c'est la première fois que vous vous
connectez à une base de données
externe à l'aide de LibreOffice Base, je
vous recommande de créer une base de
données de test en MySQL où vous

pourrez faire des erreurs et en tirer des
leçons. Vous pouvez installer un pro-
gramme comme PHP MyAdmin ou
EMMA, mais je pense qu'il est plus facile
d'utiliser simplement le client MySQL en
ligne de commande.

Pour vous connecter à MySQL sur votre
machine locale, utilisez la commande :

mysql -h localhost -u root -p

MySQL vous demandera le mot de
passe « root ». Saisissez-le et vous êtes
accueilli par un message de bienvenue et
l'invite de commande « mysql> ». Pour
vous connecter à un serveur MySQL sur
un autre ordinateur, remplacez « local-
host » par le nom du serveur ou l'adresse
IP. Gardez à l'esprit que vous aurez
besoin de paramétrer MySQL pour qu'il
accepte les connexions à distance. Pour
plus de détails sur la configuration de
MySQL pour accepter les connexions à
distance, lire ce tutoriel : http://www.cy-
berciti.biz/tips/how-do-i-enable-remote-
access-to-mysql-database-server.html

Pour créer une base de données, uti-
lisez la commande suivante à l'invite de
MySQL :

CREATE DATABASE <dbname>;

où <dbname> est le nom que vous
souhaitez donner à la base de données.
Pour créer le nom de base de données
«  myTestDB » entrez :

CREATE DATABASE myTestDB;

MySQL répond avec un message indi-
quant que la requête a été exécutée.
Entrez :

SHOW DATABASES;

pour générer une liste de toutes les
bases de données. Vous devriez voir votre
nouvelle base de données parmi celles
énumérées. Une base de données vide
est suffisante pour se connecter à
MySQL à partir de Base, mais vous pou-
vez également vous connecter à une
base de données entièrement fonction-
nelle. Cependant, comme je l'ai dit, il est
préférable de s'entraîner sur une base de
données de test en premier. Tapez « quit »
et appuyez sur Entrée pour quitter votre
session MySQL.

LLiibbrreeOOffffiiccee PP..3333 :: CCoonnnneecctteerr BBaassee àà MMyySSQQLL

http://www.cyberciti.biz/tips/how-do-i-enable-remote-access-to-mysql-database-server.html
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CONNECTEZ BASE À UNE

BASE DE DONNÉES MYSQL
Nous allons maintenant faire ce pour

quoi nous avons fait tout ce travail : une
vraie connexion de Base à la base de
données MySQL. Commencez par créer
un nouveau document de base de
données dans LibreOffice, Fichier > Nou-
veau > Base de données. Nous allons
utiliser ce document pour nous connec-
ter à la base de données que nous avons
créée auparavant. En utilisant l'assistant
de base de données (recommandé), c'est
un processus en cinq étapes.

Étape 1 : Nous voulons nous connec-
ter à une base de données existante. Ne
pas confondre avec la connexion à un
fichier de base de données existant. Vous
voulez la dernière sélection. Dans la liste
déroulante sélectionnez MySQL. Cliquez
sur Suivant.

Étape 2 : Puisque nous avons installé
le « libreoffice-mysql-connector », nous
n'avons pas besoin des connexions ODBC

ou JDBC. Sélectionnez « Connexion di-
recte ». Cliquez sur Suivant.

Étape 3 : La base de données est le
nom de la base de données que nous
venons de créer dans MySQL. Notre base
de données exemple est « myTestDB ».
Le serveur est « localhost » pour l'ordinateur
local ou le nom du serveur ou l'adresse IP
d'un autre ordinateur. Laissez le port par
défaut, sauf si vous l'avez modifié dans
vos paramètres MySQL ou que votre
service informatique vous a dit de le
faire. Cliquez sur Suivant.

Étape 4 : Le nom d'utilisateur dont
vous avez besoin pour vous connecter à
MySQL à partir de votre ordinateur.
Utilisez « root » si vous vous connectez à
MySQL sur votre ordinateur local. Cochez
la case « Mot de passe requis ». Cliquez

sur « Tester la connexion ». Vous êtes
invité à donner votre mot de passe.
Entrez votre mot de passe et cliquez sur
OK. Si vous avez tout fait correctement,
vous recevrez un message disant que
Base s'est correctement connecté à la
base de données. Cliquez sur OK, puis
cliquez sur Suivant.

Étape 5 : Sélectionnez Enregistrer ou
Ne Pas Enregistrer selon vos besoins
pour la base de données. Une base de
données enregistrée est disponible dans
d'autres modules de LibreOffice. Cochez
la case « Ouvrir la base de données pour
l'édition ». Cliquez sur Terminer. Base
vous demandera un nom de fichier.
Entrez un nom et cliquez sur Enregistrer.

Vous pouvez maintenant interagir
avec la base de données MySQL de la
même manière que vous le feriez avec
une base de données HSQLDB. Vous
pouvez créer des tables, des requêtes,
des rapports et des formulaires comme
vous le feriez avec les SGBD par défaut.
Vous devrez faire attention aux types de
données, car ils sont légèrement diffé-
rents dans MySQL. Pour un aperçu des
types de données HSQLDB voir mon
article http://wp.me/pvwht-8Q. Pour une
liste des types de données MySQL, allez à
http://dev.mysql.com/doc/refman/5.0/e
n/data-type-overview.html.

Bien qu'utiliser le SGBD par défaut
pour Base soit une bonne méthode pour
les nouvelles bases de données, il de-
vient parfois nécessaire de se connecter
à des bases de données existantes. Dans
cet article, nous avons montré comment
on fait pour se connecter à une base de
données externe que nous avons créée
avec MySQL. Nous avons installé MySQL
et créé une base de données vide. En
utilisant l'assistant de base de données
dans Base, nous sommes connectés à
cette base de données où nous pouvons
créer des tables, formulaires, requêtes et
rapports pour interagir avec la base de
données. Base peut également se con-
necter à d'autres types de bases de don-
nées comme dBase, JDBC, Oracle,
PostgreSQL, etc.

http://wp.me/pvwht-8Q
http://dev.mysql.com/doc/refman/5.0/en/data-type-overview.html
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D e nouvelles fonctionnalités et
améliorations sont apparues dans

la dernière version de LibreOffice 4.
L'une des plus intéressantes parmi elles
est le panneau latéral expérimental. Ce
dernier rassemble un grand nombre
de fonctions et d'outils en un endroit
facilement accessible, éliminant la néces-
sité d'avoir une barre d'outils de for-
matage pourun grand nombre d'objets.

Aujourd'hui, nous allons donc nous
intéresser à ce panneau latéral et
nous verrons comment il s'adapte au
document sur lequel vous êtes en train
de travailler. Souvenez-vous que ce
panneau latéral est expérimental, ce
qui signifie qu'il peut faire planter le
programme sans préavis. Lorsque vous
l'utilisez je vous recommande d'enre-
gistrer votre document très souvent.

CONFIGURATION
Étant donné que le panneau latéral

est expérimental, il nous faudra l'ac-
tiver. Depuis n'importe quel écran de
LibreOffice, allez dans Outils > Op-
tions > LibreOffice > Avancé. Cochez
la case « Activer les fonctions expéri-
mentales » et cliquez sur OK. Il faut
ensuite redémarrer LibreOffice pour
que le changement prenne effet.

PRÉSENTATION
Le panneau latéral de LibreOffice

ressemble à celui de Calligra ou au
ruban de Microsoft Office. Même s'il
ne peut pas tout remplacer, vous
aurez tendance à l'utiliser plutôt que
les barres d'outils de formatage et
autres boîtes de dialogue. Le panneau
latéral propose en fait plus de fonc-
tionnalités que la barre d'outils de
formatage par défaut.

Par défaut, la barre latérale est
placée sur le côté droit de la fenêtre
principale. Vous pouvez l'afficher ou
la masquer en utilisant le bouton affi-
cher/cacher sur le bord, ou via le menu
Affichage > Volet latéral. Le menu du
panneau latéral vous permet de l'at-
tacher/détacher. Il est également pos-
sible de la personnaliser en suppri-
mant les panneaux que vous n'uti-
liserez pas.

La barre latérale est une collection
de panneaux. Les panneaux disponibles
dépendent du programme que vous
utilisez. Vous pouvez accéder à cha-
cun d'entre eux en sélectionnant leurs
icônes sur la droite ou par le biais du
menu du panneau latéral. Chaque
panneau sert de raccourci à différents
outils dans le programme. Personnel-
lement, j'utilise le plus souvent les
panneaux Propriétés et Styles et for-
matage. Jetons un œil à chacun d'en-
tre eux.

PROPRIÉTÉS
Le panneau Propriétés présente les

propriétés d'un élément du document.
Vous pouvez y ajuster les différentes
propriétés en utilisant les icônes du
panneau. Modifier des propriétés par

le biais de ces icônes revient à effec-
tuer manuellement les changements
à travers les boîtes de dialogue et
barres d'outils, ce qui signifie que cela
n'a aucun effet sur le style sous-jacent
assigné à l'élément − uniquement sur
l'élément actuel. Si vous ne trouvez
pas la propriété, cliquez sur le bouton
« Plus d'options » présent dans le coin
de chaque propriété pour faire appa-
raître la boîte de dialogue correspon-
dante avec ses onglets. Il est possible
d'étendre et de réduire chacun des
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blocs grâce au bouton Étendre/Ré-
duire à côté de chaque titre de bloc.

Par exemple, tandis que vous tapez
dans un document Writer, vous verrez
trois blocs dans le panneau Proprié-
tés : Caractère, Paragraphe et Page.
Le bloc Caractère permet de contrô-
ler les différents paramètres liés au
texte − police de caractères, gras, ita-
lique, couleur, etc. Le bloc Para-
graphe vous donne la possibilité de
contrôler l'alignement du paragraphe,
l'espacement, les marges, etc. Le bloc
Page propose des options pour chan-
ger la taille de la page, son orien-
tation, ses marges et ses colonnes.

STYLES ET FORMATAGE

La barre latérale reprend les options

proposées dans la fenêtre « Style et
formatage ». Elle permet un accès
direct aux différents styles du docu-
ment. Bien qu'il soit toujours possible
d'utiliser le bouton dans la barre d'ou-
tils, la nouvelle barre latérale introduit
un emplacement central pour cet
outil et bien d'autres. La fenêtre pro-
pose toujours les styles divisés par
type (caractères, paragraphes, cadres,
pages et listes), aussi bien que le
menu de sous-catégories.

GALERIE

La Galerie est une collection
d'images utilisables dans vos docu-
ments. Le panneau Gallery présente
une liste de catégories, appelées thè-
mes, en haut, et une liste d'images
en-dessous. Cette bibliothèque peut

être utilisée pour insérer des ClipArt
et un arrière-plan, dans vos documents,
mais aussi des sons dans vos pré-
sentations. Vous pouvez également
ajouter et créer de nouveaux thèmes
dans votre Galerie. Un tutoriel complet
sur la bibliothèque de la Galerie sera
proposé dans un prochain article.

NAVIGATEUR

Le Navigateur est un catalogue des
titres, tableaux, sections, images, etc.,
de votre document. Il vous permet de
vous déplacer rapidement d'un point
de votre document à un autre grâce à
la référence à un objet. Cela devient
pratique dans les gros documents, et
c'est un bon argument pour donner à
vos objets OLE et à vos images un
nom lisible.

PAGES MAÎTRESSES
(UNIQUEMENT DANS IMPRESS)

Le panneau Pages maîtresses est
utilisé pour sélectionner et créer des
pages maîtresses dans Impress. J'ai ex-
pliqué les pages maîtresses dans la partie
1 6 de cette série, dans le FCM n° 63 :
http://www.fullcirclemag.fr/?downlo
ad/254. Ce panneau est simplement
une traduction de la section Pages
maîtresses du volet Tâches d'Impress.

ANIMATIONS PERSONNALISÉES
(UNIQUEMENT DANS IMPRESS)

Le panneau Animations personna-
lisées permet d'animer des objets sur
une diapositive Impress. J'ai parlé des
animations dans la partie 1 8 de cette
série, dans le Full Circle Magazine n° 65 :
http://www.fullcirclemag.fr/?downlo
ad/260. C'est également une transition
du volet Tâches d'Impress, sous un
nouveau format.

TRANSITIONS (UNIQUEMENT
DANS IMPRESS)

Les transitions contrôlent la façon
dont une présentation passe d'une
diapositive à une autre. Pour plus de
détails, voyez la partie 1 8 de cette série,

http://www.fullcirclemag.fr/?download/254
http://www.fullcirclemag.fr/?download/260
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dans le Full Circle Magazine n° 65 :
http://www.fullcirclemag.fr/?downlo
ad/260. Ce panneau est, là encore,
une copie de l'ancien volet Tâches
d'Impress.

FONCTIONS (UNIQUEMENT
DANS CALC)

Le panneau Fonctions vous donne

accès à toutes les fonctions de Calc.
Une liste divise les fonctions en ca-
tégories, incluant les catégories « Les
dernières utilisées » et « Toutes ». En-
dessous, se trouve une liste de toutes
les fonctions de la catégorie choisie.
Vous pouvez insérer les fonctions dans
la cellule courante en double-cliquant
sur le nom de la fonction ou en cli-

quant sur le bouton fx à gauche de la
liste des catégories. Cela donne un
accès rapide aux fonctions et est plus
facile (à mon avis) à utiliser que l'As-
sistant Fonction.

La barre latérale expérimentale est
un outil qui permet un accès plus
rapide, et plus facile, aux outils cou-
rants. LibreOffice a accompli cela via
l'expansion du panneau et les com-
binaisons de barres d'outils courantes,
et en traduisant d'autres panneaux et
assistants dans un nouveau format.
Vous pouvez la comparer à la barre
latérale de Calligra ou au Ruban de
Microsoft Office. Je l'ai trouvée facile
d'utilisation, mais gardez à l'esprit
que cette fonction est expérimentale
et peut parfois faire planter Libre-
Office.

ÉDITIONS SPÉCIALES PYTHON :

http://www.fullcirclemag.fr/?download/224 http://www.fullcirclemag.fr?download/230

http://www.fullcirclemag.fr/?download/231 http://www.fullcirclemag.fr/?download/240

http://www.fullcirclemag.fr/?download/268 http://www.fullcirclemag.fr/?download/272

http://eeperry.wordpress.com
http://www.fullcirclemag.fr/?download/260
http://www.fullcirclemag.fr/?download/224
http://www.fullcirclemag.fr?download/230
http://www.fullcirclemag.fr/?download/231
http://www.fullcirclemag.fr/?download/240
http://www.fullcirclemag.fr/?download/268
http://www.fullcirclemag.fr/?download/272
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R assembler des Cliparts afin de les
utiliser dans un bulletin, un tableau,

une présentation ou autre peut rapide-
ment devenir une tâche chronophage,
surtout quand il s'agit d'organiser – afin
de les retrouver plus tard – les images
que vous souhaitez utiliser. LibreOffice
fournit une « Galerie » (appelée Gallery)
intégrée pour la collecte et l'organisa-
tion de ces images, mais aussi des sons
et des vidéos. La « Galerie » comporte
des dossiers, organisés par thème. Vous
pouvez ajouter des fichiers à partir de
la Galerie directement dans votre do-
cument et vous pouvez créer des thèmes
supplémentaires pour ajouter vos pro-
pres fichiers à la collection.

LA GALERIE
Vous pouvez accéder à la Galerie de

trois manières différentes, via le menu
(Outils > Gallery), par un bouton sur la
barre d'outils standard et en utilisant

un panneau dans la barre latérale
expérimentale. Par défaut, la Galerie
est ancrée sous la barre d'outils de mise
en forme. Vous pouvez détacher et
ancrer la Galerie avec la combinaison
suivante : CTRL + double-cliquez sur la
bordure de la Galerie. Utilisez le bouton
afficher/cacher sur le bord inférieur afin
d'afficher ou de masquer la galerie
lorsqu'elle est ancrée. Si vous survolez
le bord inférieur, le curseur de la souris
se transforme en double flèche et vous
pouvez alors redimensionner la hauteur
de la Galerie.

Sur le côté gauche de la Galerie se
trouve la liste des thèmes. Le fait de
sélectionner un thème modifie les fichiers
qui s'affichent dans le panneau princi-
pal. Le panneau principal affiche les
fichiers disponibles pour le thème sélec-
tionné. Au-dessus de la zone principale
se trouvent deux boutons pour afficher
les fichiers – sous forme de miniatures

ou en vue détaillée. À côté des bou-
tons, s'affichent également le nom du
thème, le nom du fichier et son empla-
cement.

UTILISATION DE LA GALERIE
La Galerie vous permet d'insérer un

fichier en tant que copie, en tant que
lien, ou comme fond. Lorsque vous
insérez le fichier en tant que copie, il
est incorporé dans le document courant
et ne dépend pas d'un autre fichier. Si
vous insérez le fichier comme un lien,
une référence au fichier source est créée
dans le document. Si vous avez ouvert
un document avec des fichiers liés, les
fichiers ne s'affichent que s'ils sont
présents dans l'emplacement référencé
dans le document (lien vers le fichier
source). Si votre document est destiné
à être utilisé sur plusieurs ordinateurs,
insérez plutôt une copie. Si le document
ne doit résider que sur un seul ordina-
teur, vous pouvez alors n'insérer qu'un
lien.

Pour insérer la copie d'un fichier dans
le document à partir de votre Galerie,
sélectionnez le thème contenant le
fichier et sélectionnez le fichier à insérer.
Vous pouvez ensuite faire glisser et dé-
poser le fichier dans votre document,
ou faites un clic droit sur le fichier puis
Insérer > Copier.

Pour insérer un lien vers un fichier à
partir de votre galerie dans un docu-
ment, sélectionnez le thème et le fichier.
Maintenez MAJ + CTRL enfoncés tout
en faisant glisser le fichier dans le
document, ou faites un clic droit puis
Insertion > Lien.

Lorsque vous souhaitez utiliser une
image comme arrière-plan d'une page
ou d'un paragraphe, sélectionnez le
thème et l'image puis faites un clic
droit sur l'image et Ajouter > Arrière-
plan > Page. Pour définir l'image comme
fond pour le paragraphe en cours, faites
un clic droit sur l'image et Ajouter >
Arrière-plan > Paragraphe.

GESTION DE LA GALERIE
Une fonctionnalité intéressante de

la Galerie consiste en la possibilité d'ajou-
ter vos propres fichiers à la collection.
Cependant, vous ne pouvez pas ajouter
à, enlever de, ou supprimer les thèmes
par défaut. Pour ajouter vos propres
fichiers dans la Galerie, vous devez créer
vos propres thèmes. Vous pouvez ajou-
ter votre propre thème en cliquant sur
le bouton « Nouveau Thème », qui ouvre
la boîte de dialogue éponyme. Dans
l'onglet « Général », entrez le nom de
votre nouveau thème. Vous pouvez de
suite ajouter des fichiers à votre thème
dans l'onglet « Fichiers » ou cliquez sur
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« OK » pour enregistrer le thème.

Il est facile d'ajouter des fichiers au
thème que vous venez de créer. Vous
pouvez ajouter des fichiers un par un
en les faisant glisser dans le panneau
principal où vous aurez sélectionné
votre thème. Une boîte de dialogue
vous permet d'ajouter des fichiers en
les sélectionnant, voire ajouter un dos-
sier en entier : faites un clic droit sur le
titre du thème et sélectionnez « Pro-
priétés ». La boîte de dialogue « Pro-
priétés » s'affiche. Il s'agit de la même
boîte de dialogue que vous obtenez
lors de l'ajout d'un thème et vous pou-
vez donc utiliser cette méthode pour
ajouter des fichiers lorsque vous créez
un nouveau thème. Sélectionnez l'onglet
« Fichiers », puis cliquez sur « Recher-
cher des fichiers ». Utilisez la boîte de
dialogue de fichiers pour accéder au
dossier contenant le(s) fichier(s) que
vous voulez ajouter et cliquez sur « Sé-
lectionnez ». Une liste de fichiers s'af-
fiche alors dans la boîte de dialogue.

Utilisez le menu déroulant au-dessus de
la liste pour filtrer les fichiers, si néces-
saire, en fonction de leurs extensions.
Prenez le temps de parcourir la liste de
filtres pour avoir une idée des nom-
breux formats de fichiers que la Galerie
prend en charge. Pour les fichiers d'ima-
ges, vous pouvez obtenir un aperçu en
cochant la case « Aperçu ». Une fois que
vous trouvez le fichier que vous voulez,
vous pouvez le sélectionner et cliquer
sur « Ajouter » pour l'ajouter au thème,
ou cliquez sur « Ajouter tout » pour
ajouter tous les fichiers contenus dans
la liste.

Vous ne souhaitez peut-être pas
conserver tous les fichiers que vous
avez insérés dans la Galerie, mais juste
les utiliser pour un document ou un
projet en particulier. Une fois que le
projet est terminé et que vous n'avez
plus besoin de ces fichiers, vous pouvez
les supprimer en toute sécurité. Pour
supprimer un fichier d'un thème, faites
un clic droit sur le fichier et sélec-

tionnez « Supprimer ». Vous pouvez éga-
lement supprimer un thème avec tous
ses fichiers par un clic droit sur le titre
du thème et en sélectionnant « Sup-
primer ». Gardez à l'esprit qu'il n'y a pas
d'annulation pour ces actions et que la
suppression d'un fichier de la Galerie ne
le supprime pas de l'ordinateur, mais
uniquement de la liste des thèmes de
la Galerie.

En conclusion, LibreOffice fournit
une bibliothèque de médias appelé la
Galerie. La galerie est divisée en collec-
tions appelées thèmes. Vous pouvez
ajouter vos propres thèmes et vos
propres fichiers dans la Galerie. Si un
fichier ou un thème n'est ajouté que
pour un projet spécifique, vous pouvez
ensuite le supprimer lorsque le projet

est terminé. La galerie est disponible
dans tous les modules de la suite Libre-
Office et vous aide à maintenir une
certaine cohérence dans vos bulletins,
feuilles de calcul, présentations, bases
de données et rapports.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu. Son blog
est à http://eeperry.wordpress.com

http://eeperry.wordpress.com
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S i vous travaillez avec Base pendant
quelque temps, vous rencontrerez

une situation où vous aurez besoin
d'une table dont la structure est un
peu différente, où vous aurez besoin
des résultats d'une requête sous
forme d'une table que vous pourrez
utiliser. La solution à ces problèmes
est « Vues ». Une vue est une requête
sous forme d'une table qui pourra
servir dans d'autres requêtes, des for-
mulaires ou des contrôles. Aujour-
d'hui, je vous montrerai comment cela
peut vous être utile dans la création
de formulaires.

NOS TABLES
Nous allons créer une base de

données simple avec deux tables. La
base de données suivra des projets
pour une société et nous permettra
d'assigner un membre de l'équipe à
chaque projet. La structure des tables
à créer se trouve ci-dessous.
Proj ect Table
Field| Type| Properties
ID| Integer| Primary Key, Auto
Increment
Title| varchar(50) | Not Null
Description| varchar(250)
Due| Date
MemberID| Integer| foreign key

TeamMember Table
Field| Type| Properties

ID| Integer| Primary Key, Auto
Increment
FirstName| Varchar(25) | Not
Null
LastName| Varchar(25) | Not Null

Vous verrez à droite le SQL pour
créer les tables. Créez une nouvelle
base de données, puis allez à Outils >
SQL et tapez les commandes à la main
ou faites un copier/coller.

Les commandes SQL ci-dessus sont
également disponibles sur pastebin.com
à http://pastebin.com/Wyb3R5Fz.

La clé de cette tâche est la clé
externe « MemberID » dans la table
«  Project », qui est reliée au champ ID
de la table « TeamMember ». Quand
nous créons notre formulaire, nous
créons un menu déroulant permet-
tant de sélectionner le responsable du
projet parmi les membres de l'équipe.
Remarquez que la table « TeamMem-
ber » contient des champs pour le
prénom et le nom. Le contrôle de liste
nous permet d'utiliser un seul champ
dans la liste. On pourrait n'afficher que
le nom dans la liste déroulante, mais
que faire si deux membres de l'équipe
ont le même nom ? Nous allons ré-
soudre ce problème en créant une vue
qui rassemblera le prénom et le nom
dans un seul champ appelé « Name ».

Nous utiliserons notre vue pour éta-
blir la nouvelle liste déroulante.

Si les tables ne s'affichent pas dans
votre liste de tables, après avoir exé-
cuté les commandes, Affichage >
Actualiser les tables (Review > Re-
fresh Table) établira la liste.

CRÉER UNE REQUÊTE/VUE
Nous utiliserons un processus en

deux étapes pour créer notre vue.
D'abord, nous créons une requête et,
ensuite, nous convertissons la re-
quête en vue. Dans notre requête,
nous créons un seul champ en com-

binant les champs prénom et nom.
Nous obtiendrons aussi le champ « ID »,
puisque nous en aurons besoin pour
nous lier à la table « Project ».

Pour créer la requête, nous sélec-
tionnons l'option « Requêtes » dans le
volet « Base de données ». Dans le
volet « Tâches », sélectionnez « Créer
une requête en mode SQL… » La com-
mande SQL suivante créera notre
requête :

SELECT "FirstName" || ' ' | |
"LastName" AS "Name",

"ID" FROM "TeamMember";

drop table "Proj ect" if exists;
drop table "TeamMember" if exists;

create table "TeamMember" (
" ID" integer generated by default as identity

(start with 1) not null primary key,
" FirstName" varchar(25) not null,
"LastName" varchar(25) not null

) ;

create table "Proj ect" (
" ID" integer generated by default as identity

(start with 1) not null primary key,
"Title" varchar(50) not null,
" Description" varchar(250) ,
" Due" date,
"Member" integer,
constraint FK_MEM foreign key ( "Member" )

references "TeamMember" ( " ID" )
) ;

http://pastebin.com/Wyb3R5Fz
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Si vous connaissez le SQL, cela

ressemble à une requête standard sauf
pour ce qui concerne les doubles sym-
boles trait vertical « || ». On les utilise
pour concaténer les chaînes. Dans la
commande, nous sélectionnons chaque
« FirstName » et l'adjoignons à une
espace, puis nous prenons le résultat
et l'adjoignons à « LastName ». Enfin,
nous nommons cette chaîne « Name ».
Nous obtenons aussi le « ID » puisqu'il
identifie chaque enregistrement. Vous
pouvez tester la requête pour vous
assurer qu'elle fonctionne, mais, à ce
stade, les résultats sont vides, néan-
moins la requête devrait s'exécuter
sans erreur. Enregistrez la requête
sous le nom de « QueryTeam ».

Transformer la requête en vue est
aussi simple que faire un clic droit sur
le nom de la requête et sélectionner
«  Créer une vue ». Appelez la vue « Team-
View ». Si vous sélectionnez « Tables »
dans le volet « Base de données », vous
verrez que « TeamView » figure dans
la liste des tables.

CRÉER LES FORMULAIRES

Nous allons créer un formulaire
pour les membres de l'équipe et un
formulaire du projet, pour les données.
Le formulaire « membres de l'équipe »
étant le plus facile, nous allons le
créer en premier. Cliquez sur l'icône
«  Formulaires » dans le volet « Base

de données » et choisissez « Utiliser
l'assistant de création de formulaire… ».
L'Assistant Formulaire s'affichera.

Sur le premier écran, choisissez
«  Table : TeamMember » dans le menu
déroulant. Déplacez les champs « First-
Name » (prénom) et « LastName » (nom)
dans le menu déroulant appelé « Champs
du formulaire ». Cliquez sur le bouton
« Suivant > ». Il n'y a pas de sous-formu-
laire alors cliquez sur « Suivant > » à
nouveau. À l'étape 5, vous pouvez
utiliser n'importe laquelle des options
de contrôle exceptée l'option « Comme
feuilles de données ». À l'étape 6,
acceptez les défauts. À l'étape 7 vous
devez choisir un style qui vous plaît.
Quand vous arrivez à l'étape 8,
appelez le formulaire « TeamMember-
Form » et laissez sur « Utiliser le for-
mulaire ». Lorsque vous cliquez sur
«  Créer », le formulaire s'affichera pour
l'entrée de données. Ajoutez-y quel-
ques noms pour tester le formulaire
projet quand nous l'aurons terminé.

Pour le formulaire projet nous
avons besoin d'à peu près la même
chose, sauf qu'il faut utiliser « Table:
Project » à partir du menu déroulant à
l'étape 1 et qu'il faut sélectionner tous
les champs sauf « ID » comme champs
du formulaire. Appelez-le « ProjectForm »
et, à l'étape 8, choisissez « Modifier le
formulaire ». Cette fois-ci, au lieu de
s'afficher pour que vous puissiez y

entrer des données, il s'affiche pour
que vous puissiez l'éditer.

Quand vous créez des formulaires
avec l'assistant de création de formu-
laire, l'assistant groupe une zone texte
pour la plupart des types de données
avec une étiquette pour chaque champ.
Pour changer le contrôle d'un champ
de données, il faut dissocier la zone
texte de l'étiquette. Ici, nous voulons
modifier le champ « Member ». Pour ce
faire, faites un clic-croit sur l'étiquette
et la zone texte de «Member » et sélec-
tionnez Groupe > Dissocier. Cliquez
sur le fond du formulaire pour désé-
lectionner les deux. Faites un clic droit
sur la zone de texte et choisissez « Sup-
primer ». Sélectionnez « Zone de liste »
sur la barre d'outils « Contrôles de
formulaire ». Si cette barre n'est pas
affichée, alors, pour l'afficher, faites
Affichage > Barres d'outil > Contrôles
de formulaire. Une fois Zone de liste
sélectionnée, le curseur prendra la
forme d'une croix, +. Cliquez et déplacez
pour créer le menu déroulant. Quand
vous lâcherez le bouton de la souris,
l'Assistant Zone de liste s'affichera.

Comme table, sélectionnez « Team-
View » et cliquez sur « Suivant > ». Le
champ que nous voulons dans la Zone
de liste est « Name » ; sélectionnez
donc«Name »etcliquez sur« Suivant> ».
Enfin, il faut « Sélectionner les champs
dont le contenu doit coïncider ». Pour

la « Value Table », choisissez « Mem-
ber ». Il faut sélectionner ID comme
champ pour « List Table », car c'est la
clé primaire qui s'accorde avec le
champ de clé externe « Member » dans
la table « Project ».

Enregistrez les modifications et
fermez la fenêtre d'édition.

Maintenant, si vous avez mis des
noms dans le formulaire « TeamMem-
berForm », vous pouvez ouvrir « Pro-
jectForm » et ces noms-là s'afficheront
dans le menu déroulant que nous
venons de créer. Vous voudrez sans
doute créer plusieurs projets et leur
assigner des membres pour tester le
fonctionnement de vos formulaires.

Dans cet article, nous avons parlé
de l'utilisation d'une vue de Libre-
Office Base pour créer une nouvelle
table à partir d'une table existante.
Nous avons utilisé cette vue pour cons-
truire un formulaire automatisant la
récupération et la sélection d'enregis-
trements à partir de cette vue.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un grand
bol de Linux et Ubuntu. Son blog est à :
http://eeperry.word-press.com

http://eeperry.wordpress.com

